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Safety Precautions
The precautions noted within this guide are intended to instruct you in the safe and 
correct use of the products and to prevent injuries or damage to yourself, other 
persons and property. Please read and ensure that you understand them before 
proceeding to other sections of the guide.

Trademark Acknowledgments
• Canon is a trademark of Canon Inc.
• iBook and iMac are trademarks of Apple Computer, Inc.
• Macintosh, PowerBook, Power Macintosh and QuickTime are trademarks of Apple Computer Inc., 

registered in the United States and other countries.
• Other names and products not mentioned above may be registered trademarks or trademarks of their 

respective companies.

Copyright © 2004 Canon Inc. All rights reserved.

This symbol indicates topics that could lead to death or serious injury if ignored 
or handled incorrectly.

Do not play the supplied CD-ROM(s) in any CD player that does not support data CD-ROMs. Playing the 
CD-ROM(s) in an audio CD player (music player) could damage the speakers. It is also possible to suffer 
from hearing loss from listening with headphones to the loud sounds of a CD-ROM played on a music CD 
player.

Disclaimer
• While every effort has been made to ensure that the information contained in this guide is accurate and 

complete, no liability can be accepted for any errors or omissions. Canon reserves the right to change 
the specifications of the hardware and software described herein at any time without prior notice.

• No part of this guide may be reproduced, transmitted, transcribed, stored in a retrieval system, or 
translated into any language in any form, by any means, without the prior written permission of Canon.

• Canon makes no warranties for damages resulting from corrupted or lost data due to a mistaken 
operation or malfunction of the camera, the software, the CompactFlash™ cards (CF cards), personal 
computers, peripheral devices, or use of non-Canon CF cards.

Symbols Used in This Document

Indicates important items or prohibited actions that should always be observed when 
operating the machine. These should always be read to avoid damage to the 
machine or improper operation.

Indicates items for reference or supplementary information that should be noted by 
users.

Warning

Warning
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Read This First

About the Manuals

This user guide describes how to connect the printer to your computer and 
print images.

Printer
(CP-330/CP-220)

User Guide

Provides printer handling notes, safety precautions, 
printer preparation, names of parts and other information 
necessary for operating the printer. Please read before 
using the printer.

This user guide

Describes how to connect the printer to your computer, 
printer driver installation, functions and operating 
procedures.

Explanations for Mac OS X are based on Mac OS X v10.1. If you are using 
another version of Mac OS X, the actual screen contents and procedures may 
vary slightly from those shown.

Detailed explanations of operating procedures are given in the [Help] 
accompanying each software application.

If a problem occurs, refer to the following:

• Trouble with the printer itself: See the Printer User Guide.
• Printing problems: See this user guide.
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Printing Flow Diagram

Follow the steps outlined below to prepare the printer and install the 
necessary software on your computer to enable printing.

Prepare the printer.
Insert paper cassette and ink cassette.

See the Printer User Guide.

Install the necessary software on your 
computer.
Install the necessary software on your computer from the CP 
Printer Solution disk.

See the Printer User Guide.

Install the printer driver.
Install the printer driver onto your computer.

Turn the printer’s power on.
Turn the printer’s power on and connect the printer to your 
computer.

See
Turning On the Printer (➡ p.14),
Connecting the Printer to Your Computer (➡ p.15) in this user guide.

Continued next page.

See
Installing the Printer Driver (➡ p.8) in this user guide.

To uninstall the printer driver,
see Uninstalling (➡ p.11) in this user guide. 
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About the Connection Cable

The printer can be connected to a computer using a standard USB cable.
For details, see Specifications (Interface) in the Printer User Guide.

Select an image to print.
Start ImageBrowser and select an image to print.

See
Starting ImageBrowser (Mac OS 9.0 - 9.2 ➡ p.18, Mac OS X ➡ p.37),
Selecting an Image for Printing (Mac OS 9.0 - 9.2 ➡ p.19, Mac OS X ➡ p.37) 
in this user guide.

Printing.
Print on standard sheet or full-size labels.

To print an 8-label sheet,

see
Printing Duplicate Images on an 8-Label Sheet
(Mac OS 9.0 - 9.2 ➡ p.27, Mac OS X ➡ p.46) or
Printing Different Images on an 8-Label Sheet
(Mac OS 9.0 - 9.2 ➡ p.30, Mac OS X ➡ p.49) in this user guide.

See
Selecting a Layout Type
(Mac OS 9.0 - 9.2 ➡ p.20, Mac OS X ➡ p.39)
Setting the Printer Driver for Printing
(Mac OS 9.0 - 9.2 ➡ p.23, Mac OS X ➡ p.42)
in this user guide.
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Installing the Printer Driver
This section describes how to install the printer driver on your computer.

Installing

1 Close any programs that are running.

2 Place the Canon CP Printer Solution Disk in the CD-ROM drive.

3 With Mac OS 9.0 - 9.2, double-click the [Canon CP Printer Installer] 
icon in the [Mac OS 9] folder on the CD-ROM. 
With Mac OS X, double-click the [Canon CP Printer Installer] icon 
in the [Mac OS X] folder on the CD-ROM.
The installer panel appears.

4 Click the CP Printer Driver [Install] button.

5 Read the software license agreement. If you agree to all of its 
conditions, click the [Agree] button.
The installer starts.

For details on how to uninstall the printer driver, see Uninstalling (➡ p.11)
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6 Select [Easy Install], and then click the [Install] button.

7 Click the [Continue] button to automatically close any applications 
other than the installer.

8 Follow the messages on the screen to proceed.

9 When installation is completed, click the [Restart] button.
Before the printer driver will operate, you must restart your computer.
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■ With Mac OS X
Continuing from the above procedure, do the following:

1) Turn the printer’s power on. (➡ p.14)

2) After your computer restarts, connect the printer to computer with the USB 
cable. 
For information on how to connect the printer, see Connecting the Printer to 
Your Computer (➡ p.15).

3) Double-click the hard disk icon where Mac OS X is installed.

4) Double-click the [Applications] folder.

5) Double-click the [Utilities] folder.

6) Double-click the [Print Center] or [Print Setup Utility] icon.
The Printer List window appears.

7) Click the [Add Printer] or [Add] button.

8) Select [USB], select the printer name, and then click the [Add] button.

9) Close the window by clicking  in the upper left-hand corner.
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To uninstall the printer driver, use the installer.

Important
Be sure to follow the procedures described in this section to uninstall the printer.

1 Close any programs that are running.

2 Place the Canon CP Printer Solution Disk in the CD-ROM drive.

3 With Mac OS 9.0 - 9.2, double-click the [Canon CP Printer Installer] 
icon in the [Mac OS 9] folder on the CD-ROM. 
With Mac OS X, double-click the [Canon CP Printer Installer] icon 
in the [Mac OS X] folder on the CD-ROM.
The installer panel appears.

4 Click the CP Printer Driver [Install] button.

5 Read the software license agreement. If you agree to all of its 
conditions, click the [Agree] button.
The installer starts.

Uninstalling

Uninstall the printer driver if it is no longer needed, or if a problem occurs 
and uninstalling becomes necessary. Note that if you uninstall the printer 
driver, you will no longer be able to use the printer to print.
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6 Select [Uninstall], and then click the [Uninstall] button.

7 Click the [Continue] button to automatically close any applications 
other than the uninstaller.

8 After uninstallation has been completed, click the [OK] button.
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■ With Mac OS X
To continue, you must do the following:

1) Double-click the hard disk icon where Mac OS X is installed.

2) Double-click the [Applications] folder.

3) Double-click the [Utilities] folder.

4) Double-click the [Print Center] or [Print Setup Utility] icon. 
The Printer List window appears.

5) Select the printer you uninstalled, and then click the [Delete] button.

6) Close the window by clicking  in the upper left-hand corner.
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Turning On the Printer

Refer to the above figure during the following procedure (the numbers in the 
figure correspond to the steps in the procedure).

1 Place the printer on a flat surface.
When printing, the paper temporarily projects out from the rear, so allow a clear 
space of at least 15 cm (6 inches) in the back.

2 Connect the supplied power cord to the CA-CP100 Compact Power 
Adapter (also supplied).

3 Plug the power cord into a power outlet.

4 Connect the Compact Power Adapter cable to the printer.
At this point the CP-220 is ON, so the printer’s indicator lights green.

5 Press the ON/OFF button (only on the CP-330).
When the printer is turned on, the printer's indicator lights green.

To Turn the Printer Off
• With CP-330: Press the ON/OFF button, releasing it when the indicator 

turns off.
• With CP-220: Unplug the Compact Power Adapter from the printer 

(the indicator turns off).

• When making connections, confirm that the shape of the plug matches 
the shape of the socket on the device being connected.

• The power outlet where the printer's power plug is connected should be 
located where the plug can be easily removed if a problem occurs.

1
2

3
4

5

Compact
Power Adapter

To Power Outlet

At least 15 cm (6 inches) of
open space in the front and back, 
and at least 10 cm (4 inches) 
on the left and right.
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Connecting the Printer to Your 
Computer
■ Notes about connection

• Using the USB cable, be sure to connect the printer directly to your computer. If 
you connect it via a USB hub, the printer may not function properly.

• Do not use the printer together with other USB devices (except a USB mouse or 
keyboard); otherwise the printer may not function properly. If this happens, 
disconnect the other USB devices from your computer and then reconnect the 
printer.

• Do not connect two or more direct print compatible printers (all CP series 
printers) to the same computer; otherwise the printers may not function properly.

Do not put your computer into the sleep mode while the printer is connected 
to a USB port.
If you accidentally do so, do not disconnect the USB cable from your 
computer while it is in the sleep mode; instead, leaving the USB cable 
connected, first return your computer to its normal mode. If you remove the 
USB cable while your computer is in the sleep mode, your computer may 
not be able to return to its normal mode. For details on your computer’s
sleep mode, refer to the documentation provided with your computer.
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1 Connect one end of the USB cable to the USB port on the printer, 
and the other end to a USB port on your computer.
• There is no need to turn off the printer or your computer.
• When connecting the printer to your computer, make sure the connectors on 

the ends of the USB cable match the ports on the printer and your computer.
• For the location and direction of your computer’s USB port, refer to the 

documentation provided with your computer.

• If your computer has more than one USB port, it does not matter 
which USB port you use to connect the printer.

• There is no need to turn off the printer or your computer when 
disconnecting the USB cable.

USB port
on computer

USB cable
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Printing
This section describes how to use ImageBrowser to print images with the 
printer.
ImageBrowser is an application included on the Canon CP Printer Solution 
Disk. This application makes it easy to print.

The screen examples and descriptions given in this section are for 
the CP-330. Operate the CP-220 in the same way.

Before printing, verify that the printer is on (the indicator on the printer is green), 
and that the printer is properly connected to your computer with a USB cable.

Printers and computer displays use different color reproduction methods, 
and lighting conditions and display settings affect the appearance of colors 
on your computer’s display. Therefore, the colors in prints may differ from 
what you see on the screen. This is not a printer malfunction.

For information on how to install ImageBrowser, see the Printer User Guide.
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With Mac OS 9.0 - 9.2

Selecting a Printer with the Chooser

1 Open the  (Apple) menu and select  [Chooser].

2 Click the [CP Printer Driver] icon.
If the printer is connected, it appears in the [Destination] list.

3 Click the CP-330 or CP-220 in the [Destination] list, then close the 
Chooser dialog by clicking  in the upper left-hand corner.

Starting ImageBrowser

1 Double-click the [Canon ImageBrowser] icon on the desktop.
If the [Canon ImageBrowser] icon does not appear on the desktop, double-click 
the [Canon Utilities] folder, [ImageBrowser] folder, and [ImageBrowser] icon.
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Selecting an Image for Printing

1 Select an image you want to print from the browser area. Click the 
 (PRINT) button to display a menu. From the menu, select 

[Layout printing].

The Print window and Layout Options window appear.

Browser
area

When the CP-220 or CP-330 is selected, you cannot select [Index printing].

Print window
You can check the 
layout of the image.

Layout Options 
window
You can adjust the 
settings for printing.
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Selecting a Layout Type
This section describes how to select a layout type, and then print on 
standard sheets or full-size label sheets. For information on how to print on 
8-label sheets, see Printing Duplicate Images on an 8-Label Sheet (➡ p.27) 
or see Printing Different Images on an 8-Label Sheet (➡ p.30).

1 Select “Photo printer standard printing” in the Layout Options 
window and then click the [Next] button.

2 Click the [Page setup] button.

Selecting “Custom layout printing” in the Layout Options window allows 
you to freely specify the size and position of images for printing. You can 
also use this option to add text in the Print window to create greeting 
cards and so on. There are 3 methods for adding text, as shown below.

• To add a caption to an image: Click the image and select [Edit 
Caption] from the [Edit] menu. 

• To edit the page title: Select [Edit Header] from the [Edit] 
menu.

• To insert text: Select [Add Text] from the [Edit] menu.
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3 Make [Paper Size] and [Orientation] selections, and then click the 
[OK] button.

4 After returning to the Layout Options window, select “Bordered”
or “Borderless”, then click the [OK] button.
If you select “Bordered”, the image is automatically resized to fit within the print.

Select the paper 
size.

Select the paper 
direction.
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The layout settings are reflected in the Print window.

[LAYOUT OPTIONS] button
Redisplays the Layout Options 
window, where you can change 
the settings.

*The image shown is bordered.
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Setting the Printer Driver for Printing
This section describes printing with modified printer driver settings.

1 Click the  (PRINT) button.

2 Select [Color].

3 To adjust image quality, select [Custom].

Custom
Click the [Adjust] button to adjust image quality freely.

The default is 
[Non adjustment].
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4 After selecting [Custom] and clicking the [Adjust] button, adjust 
the brightness and color of the print result, then click the [OK] 
button.
For details, check the balloon help.

5 Select [Background Printing] and select a printing method.

Adjust the brightness 
and contrast of prints.

Adjust the color of 
prints.

Select [Background 
Printing] to print in the 
background. This allows 
you to use other 
applications while 
printing.
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6 Select [General], set the various options, and then click the [Print] 
button.
Verify that the CP-330 or CP-220 is selected in [Printer]. For [Destination], you 
can select the following types of output.
- Printer: Output is directed to the printer.
- File: Output is directed to a PICT file.

Printing starts.

When printing in the background, printing cannot be resumed if the 
printer runs out of paper while printing. To avoid this, load more sheets 
of paper than required for the number of images to be printed.

If you stop printing while printing is in progress, paper is ejected to the 
paper handling slot and an error message may be displayed. This is not a 
malfunction, but a mechanism for protecting the print head.
If you interrupt printing while it is in progress, be sure to check the printer 
status.

• When the indicator light is green:
You can continue to print.

• When the indicator light is red:
Temporarily remove paper from the paper handling slot. Turn the 
printer off and then back on again. Make sure the indicator light is now 
green, and then print again.

Note that when printing is interrupted, one print's equivalent of the ink 
cassette's ink sheet is used.

When multiple images 
are selected, specify the 
pages (images) to be 
printed.

To print multiple copies 
of images, enter the 
number of prints desired.
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You can save [Color] and [Background Printing] settings as [Profiles].

■ To register a profile

1 Make [Color] and [Background Printing] settings.

2 Select [Add Profile] from the [Default Settings] menu, type in a 
name and comment, and then click the [OK] button.

Registering Profiles
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Printing Duplicate Images on an 8-Label Sheet
ImageBrowser allows you to print duplicate images. This makes it possible 
to print multiple copies of the same image on an 8-label sheet.

1 In the Layout Options window, select “Photo printer multiple 
printing”, and then click the [Next] button.

2 Click the [Page setup] button.
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3 For [Paper Size], select [CP_C size (L)], select the orientation, and 
then click the [OK] button.

4 After returning to the Layout Options window, click the [OK] 
button.
Images are resized to fit the label dimensions and are displayed in the Print 
window.

5 Click the image and select [Copy Image] on the ImageBrowser 
[Edit] menu.
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6 Enter 7 and click the [OK] button.

The images are laid out in replicate, with their positions adjusted for the eight 
labels on the 8-label sheet.

7 Click the  (PRINT) button to start printing.
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Printing Different Images on an 8-Label Sheet
You can also print a combination of different images on an 8-label sheet.

1 In the Layout Options window, select “Photo printer multiple 
printing”, and then click the [Next] button.

2 Click the [Page setup] button.

3 For [Paper Size], select [CP_C size (L)], select the orientation, and 
then click the [OK] button.
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4 After returning to the Layout Options window, click the [OK] 
button.

5 From the browser area, drag and drop the images to be printed 
onto the Print window.
The different images are laid out with their positions adjusted for the eight labels 
on the 8-label sheet.

6 Click the  (PRINT) button to start printing.
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Merging Images to Print a Panorama
You can create panoramic images by merging multiple images, and then 
printing them on wide paper. This operation is performed using the 
PhotoStitch software.

1 Open ImageBrowser and select the series of images you want to 
merge from the browser area.

2 Select [PhotoStitch] from the [Edit] menu.
PhotoStitch starts.

3 Merge the images following the instructions in the guidance panel 
at the top of the PhotoStitch window. 

4 Save your panoramic image, and then close PhotoStitch.

5 Print the panoramic image.

When you use images captured with a Canon digital camera in Stitch Assist 
mode, PhotoStitch determines the order and direction of the composition 
automatically, facilitating the composition process.

To print the merged images, see Selecting an Image for Printing
(➡ p.19).

Instructions
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Printing Part of an Image (Trimming)
You can select and then print a portion of an image (trimming).
This is useful when you only want to print part of an image, or if the part you 
are most interested in is not at the center of the image.

1 Click the image you want to print, then select [Clipping] on the 
ImageBrowser [Edit] menu.

• You can print portions of images selected from any type of layout.
• The length-to-width ratio cannot be modified if you select “Photo printer 

standard printing” in the Layout Options window, and then specify 
“Borderless”, or if you select “Photo printer multiple printing”. Also, 
because a 1 - 3 mm border is trimmed from the image during printing, we 
recommend that you select an area that is slightly larger than the part of 
the image you want to print.
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2 Select the portion of the image to be printed, then close the 
Clipping window.

The Clipping window closes and the selected area appears in the Print window.

3 Click the  (PRINT) button to start printing.

After selecting the 
portion to be 
printed, this closes 
the window.

The area inside the 
dotted line is the 
portion of the image 
to be printed.

Changes the size of 
the window.

Clicking here changes the orientation of the trim frame.
These buttons do not appear when “Bordered” is selected.
One orientation or the other is selected by default when “Bordered” is not selected.
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Printing with Image Quality Correction
ImageBrowser has a function that supports Exif 2.2 (referred to as Exif Print),
allowing you to automatically optimize print quality and print clearer, better-
looking images.

1 Click the image you want to print, and select [Preferences] from 
the ImageBrowser [Edit] menu.

The image quality correction is adopted for all images printed from 
ImageBrowser.
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2 Select [Print] in the Preferences window, set image quality 
correction, and then click the [OK] button.

3 Click the (PRINT) button to start printing.

Camera information such as scene and photographic conditions are 
embedded in images captured with cameras compatible with Exif 2.2 
(referred to as Exif Print). This information can be passed onto the 
printer through ImageBrowser (Exif Print-compatible software) so that 
prints are clearer.

Automatically corrects 
only images captured 
with Exif 2.2 compatible 
cameras.

Be sure to select the check box 
when using image quality correction.

Automatically corrects 
images captured with 
Exif 2.2 compatible 
cameras and other 
images.
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With Mac OS X

Starting ImageBrowser

1 Double-click the [Canon ImageBrowser] icon on the desktop.
If the [Canon ImageBrowser] icon does not appear on the desktop, double-click 
the [Canon Utilities] folder, [ImageBrowser] folder, and [ImageBrowser] icon.

Selecting an Image for Printing

1 Select an image you want to print from the browser area. Click the 
 (PRINT) button to display a menu. From the menu, select 

[Layout printing].

To use index printing, display the Index Printing window by clicking the 
(PRINT) button and selecting [Index printing] from the menu that 

appears. Set thumbnail and paper sizes, then click the [Start printing] 
button to start index printing.

Browser
area
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The Print window and Layout Options window appear.

Print window
You can check the 
layout of the 
image.

Layout Options 
window
You can adjust the 
settings for 
printing.

When [Prints to the Canon Compact Photo Printer] is not 
displayed, install the CP-330 or CP-220 printer driver (➡ p.8).
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Selecting a Layout Type
This section describes how to select a layout type, and then print on 
standard sheets or full-size label sheets. For information on how to print on 
8-label sheets, see Printing Duplicate Images on an 8-Label Sheet (➡ p.46) 
or see Printing Different Images on an 8-Label Sheet (➡ p.49).

1 In the Layout Options window, select “Prints to the Canon 
Compact Photo Printer”, select “Photo printer standard printing”,
and then click the [Next] button.

2 Click the [Page Setup] button.

Selecting “Custom layout printing” in the Layout Options window allows 
you to freely specify the size and position of images for printing. You can 
also use this option to add text in the Print window to create greeting 
cards and so on. There are 3 methods for adding text, as shown below.

• To add a caption to an image: Click the image and select [Edit 
Caption] from the [Edit] menu. 

• To edit the page title: Select [Edit Header] from the [Edit] 
menu.

• To insert text: Select [Add Text] from the [Edit] menu.
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3 In [Format for] select [CP-330] or [CP-220], make [Paper Size] and 
[Orientation] selections, and then click the [OK] button.

4 After returning to the Layout Options window, select “Bordered”
or “Borderless”, then click the [OK] button.
If you select “Bordered”, the image is automatically resized to fit within the print.

Select the paper size.

Select the paper 
direction.

Select [CP-330] or 
[CP-220].
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The layout settings are reflected in the Print window.

[LAYOUT OPTIONS] button
Redisplays the Layout Options 
window, where you can change 
the settings.

*The image shown is bordered.
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Setting the Printer Driver for Printing
This section describes printing with modified printer driver settings.

1 Click the  (PRINT) button.

2 In [Printer] select [CP-330] or [CP-220].

3 Select [Color].

This pop-up menu 
contains various settings. 
(Do not change the 
[Layout] setting.)
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4 To adjust image quality, select [Custom]. 

Custom
Click the [Adjust] button to adjust image quality freely.

5 After selecting [Custom] and clicking the [Adjust] button, adjust 
the brightness and color of the print result, then click the [OK] 
button.
For details, check the help menu.

The default is 
[Non adjustment].

Adjust the brightness 
and contrast of prints.

Adjust the color of 
prints.
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6 Select [Copies & Pages], and set the various options.

When printing in the background, printing cannot be resumed if the 
printer runs out of paper while printing. To avoid this, load more sheets 
of paper than required for the number of images to be printed.

Selecting [Save Custom Setting] allows you to save the current settings for 
[Copies & Pages], [Layout], [Output Options] and [Color]. For Mac OS X 
v10.2/v10.3, the same settings can be saved when selecting [Save As] in 
[Presets].

When selecting 
multiple images, 
specify the pages 
(images) to be printed.

To print multiple 
copies of images, 
enter the number of 
prints desired.
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7 Click the [Print] button.

Printing starts.

To use a registered setting, select [Custom]. For Mac OS X v10.2/v10.3, 
select the name you entered after selecting [Save As] in [Presets].

You can save data as a PDF file by selecting [Output Options], selecting 
“Save as File” and then clicking the [Save] button.

If you stop printing while printing is in progress, paper is ejected to the 
paper handling slot and an error message may be displayed. This is not a 
malfunction, but a mechanism for protecting the print head.
If you interrupt printing while it is in progress, be sure to check the printer 
status.

• When the indicator light is green:
You can continue to print.

• When the indicator light is red:
Temporarily remove paper from the paper handling slot. Turn the 
printer off and then back on again. Make sure the indicator light is now 
green, and then print again.

Note that when printing is interrupted, one print's equivalent of the ink 
cassette's ink sheet is used.
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Printing Duplicate Images on an 8-Label Sheet
ImageBrowser allows you to print duplicate images. This makes it possible 
to print multiple copies of the same image on an 8-label sheet.

1 In the Layout Options window, select “Prints to the Canon 
Compact Photo Printer”, select “Photo printer multiple printing”,
and then click the [Next] button.

2 Click the [Page Setup] button.

3 In [Format for] select [CP-330] or [CP-220].
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4 For [Paper Size], select [CP_C size (L)], select the orientation, and 
then click the [OK] button.
Images are resized to fit the label dimensions and are displayed in the Print 
window.

5 After returning to the Layout Options window, click the [OK] 
button.

6 Click the image and select [Copy Image] on the ImageBrowser 
[Edit] menu.

7 Enter 7 and click the [OK] button.
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The images are laid out in replicate, with their positions adjusted for the eight 
labels on the 8-label sheet.

8 Click the  (PRINT) button to start printing.
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Printing Different Images on an 8-Label Sheet
You can also print a combination of different images on an 8-label sheet.

1 In the Layout Options window, select “Prints to the Canon 
Compact Photo Printer”, select “Photo printer multiple printing”,
and then click the [Next] button.

2 Click the [Page Setup] button.

3 In [Format for] select [CP-330] or [CP-220].
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4 For [Paper Size], select [CP_C size (L)], select the orientation, and 
then click the [OK] button.

5 After returning to the Layout Options window, click the [OK] 
button.

6 From the browser area, drag and drop the images to be printed 
onto the Print window.
The different images are laid out with their positions adjusted for the eight labels 
on the 8-label sheet.

7 Click the  (PRINT) button to start printing.
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Merging Images to Print a Panorama
You can create panoramic images by merging multiple images, and then 
printing them on wide paper. This operation is performed using the 
PhotoStitch software.

1 Open ImageBrowser and select the series of images you want to 
merge from the browser area.

2 Select [PhotoStitch] from the [Edit] menu.
PhotoStitch starts.

3 Merge the images following the instructions in the guidance panel 
at the top of the PhotoStitch window.

4 Save your panoramic image, and then close PhotoStitch.

5 Print the panoramic image.

When you use images captured with a Canon digital camera in Stitch Assist 
mode, PhotoStitch determines the order and direction of the composition 
automatically, facilitating the composition process.

To print the merged images, see Selecting an Image for Printing
(➡ p.37).

Instructions
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Printing Part of an Image (Trimming)
You can select and then print a portion of an image (trimming).
This is useful when you only want to print part of an image, or if the part you 
are most interested in is not at the center of the image.

1 Click the image you want to print in the Print window (➡ p.38), 
then select [Clipping] on the ImageBrowser [Edit] menu.

• You can print portions of images selected from any type of layout.
• The length-to-width ratio cannot be modified if you select “Photo printer 

standard printing” in the Layout Options window, and then specify 
“Borderless”, or if you select “Photo printer multiple printing”. Also, 
because a 1 - 3 mm border is trimmed from the image during printing, we 
recommend that you select an area that is slightly larger than the part of 
the image you want to print.
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2 Select the portion of the image to be printed, then close the 
Clipping window.

The Clipping window closes and the selected area appears in the Print window.

3 Click the  (PRINT) button to start printing.

After selecting 
the portion to be 
printed, this 
closes the 
window.

The area inside 
the dotted line is 
the portion of the 
image to be 
printed.

Changes the 
size of the 
window.

Clicking here changes the orientation of the trim frame.
These buttons do not appear when “Bordered” is selected.
One orientation or the other is selected by default when “Bordered” is not selected.
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Printing with Image Quality Correction
ImageBrowser has a function that supports Exif 2.2 (referred to as Exif Print),
allowing you to automatically optimize print quality and print clearer, better-
looking images.

1 Click the image you want to print, and select [Preferences] from 
the ImageBrowser [ImageBrowser] menu.

2 Select [Print] in the Preferences window, set image quality 
correction, and then click the [OK] button.

The image quality correction is adopted for all images printed from 
ImageBrowser.

Automatically corrects 
only images captured 
with Exif 2.2 compatible 
cameras.

Be sure to select the check box 
when using image quality correction.

Automatically corrects 
images captured with 
Exif 2.2 compatible 
cameras and other 
images.
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3 Click the (PRINT) button to start printing.

Camera information such as scene and photographic conditions are 
embedded in images captured with cameras compatible with Exif 2.2 
(referred to as Exif Print). This information can be passed onto the 
printer through ImageBrowser (Exif Print-compatible software) so that 
prints are clearer.
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Appendices

About the Print Area and Pixels

Print Area
The shaded area ( ) in the following diagrams indicates the maximum 
printable area.
Note that because the print area is larger than the actual paper size, a 
border is trimmed from the image when it is printed.
(shown in millimeters)

Postcard size sheet

2.
0

2.
0

3.02.0

10
0.

0

148.0
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L size sheet

Credit card size sheet/full-size label sheet

2.
0

2.
0

2.62.6

89
.0

119.0

1.01.0

1.
0

1.
0

86.0

54
.0
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Wide size sheet

Number of Pixels

* Number of pixels of print area. This also includes the border that is 
trimmed from around an image during printing.

Paper Type
Total number of 

pixels (dots)*
Effective number of 

pixels (dots)

Postcard size sheet 1232 × 1808 approx. 1180 × 1748

L size sheet 1100 × 1456 approx. 1050 × 1406

Credit card size sheet/
full-size label sheet

672 × 1066 approx. 638 × 1016

Wide size sheet 1232 × 2416 approx. 1180 × 2362

2.
0

2.
0

2.02.0

10
0.

0

200.0
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Troubleshooting

This section describes how to troubleshoot problems.

Correction : Make sure the indicator on the printer light is green. (➡ p.14)

Correction : Check the USB cable to make sure it is connected correctly. (➡ p.15)

Correction : In the Chooser dialog, select the printer. (➡ p.18)

Correction : Restart the print queue from the [File] menu of the Printer Monitor.

Correction : Check the USB cable to make sure it is connected correctly. (➡ p.15)

Correction : Be sure to use the USB cable to connect the printer directly to your 
computer. If you connect via a USB hub, the printer may not function 
properly.

Correction : Printers and computer displays use different color reproduction 
methods, and lighting conditions and display settings affect the 
appearance of colors on your computer’s display. However, you can 
adjust color using [Adjust] (Mac OS 9.0 - 9.2 ➡ p.24, Mac OS X 
➡ p.43). 

If the problem still exists after trying these solutions, restart your computer. 
If the problem still persists, uninstall the printer driver and then install it again.

Printing does not start.

Cause : No power is supplied to the printer.

Cause : The USB cable is not connected correctly.

Cause : Your printer is not selected as the output destination 
(Mac OS 9.0 - 9.2 only).

Cause : The queue is stopped. (When printing in the background)

Printing stops while it is in progress.

Cause : The USB cable is not connected correctly.

Cause : A USB hub is being used for the connection.

The color of an image seen on the screen is different from that 
seen in prints.
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Error Messages

If an error occurs while printing is in progress, an error message appears on 
the screen of your computer.
This section contains a list of error messages as well as the information on 
how to troubleshoot them.

■ Errors where printing can resume
If any of the following messages appear, printing can still resume. After 
using the recommended solution to clear the error, printing restarts 
automatically.

Correction : Replace the ink cassette with a new one.

Correction : Insert the ink cassette into the printer.

• If the error does not go away after you have tried the recommended 
solutions, consult your nearest Canon Customer Support Help Desk.

• Use the information in this section in conjunction with the Printer User 
Guide.

Printer error
Ink cassette is empty. 
To resume printing, insert a new ink cassette.

Cause : There is no more ink in the ink cassette.

Printer error
No ink cassette installed in printer. 
To enable printing, insert an ink cassette.

Cause : The ink cassette is not inserted into the printer.
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Correction : Remove the paper cassette, and then insert it back into the printer 
correctly.

Correction : Remove the paper, and then insert it back into the paper cassette 
correctly.

Correction : Add more paper to the paper cassette.

After using the recommended solution to clear the error, press the [Resume] button 
to resume printing.

Correction : Make sure the indicator on the printer light is green. (➡ p.14)

Correction : Check the USB cable to make sure it is connected correctly. (➡ p.15)

Correction : Insert the paper cassette into the printer.

No paper.
Check that paper is correctly loaded in the paper cassette,
and that the paper cassette is correctly installed.

Cause : The paper cassette is not inserted correctly.

Cause : Paper is not inserted correctly in the paper cassette.

Cause : There is no paper in the paper cassette.

When printing in the background, printing cannot be resumed if the printer 
runs out of paper while printing. To avoid this, load more sheets of paper 
than required for the number of images to be printed.

Printer is not responding. Check the printer power connection, 
make sure the printer is switched on, and then try again.

Cause : No power supplied to the printer.

Cause : The USB cable is not connected correctly.

No Paper Cassette has been found. Insert an appropriate Paper 
Cassette.

Cause : The paper cassette is not inserted.
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Correction : Replace the paper with the correct size.

Correction : Insert the correct paper cassette.

Correction : Insert the correct ink cassette.

Correction : Insert the correct ink cassette and paper.

Correction : Use a new or fully charged battery pack, or use the printer with the 
AC adapter (compact adapter) connected. 

Wrong type of paper. Replace the Paper.

Cause : The paper is not suitable for the print settings.

Wrong type of Paper Cassette. Check the Paper Cassette.

Cause : The paper cassette in the printer is not suitable for the print 
settings.

The specified Ink Cassette cannot be found. 
Replace the Ink Cassette.

Cause : The ink cassette in the printer is not suitable for the print 
settings.

The specified Ink Cassette and Paper cannot be found.
Replace the Ink Cassette and Paper.

Cause : The ink cassette and paper in the printer are not suitable for the 
print settings.

The battery capacity of the printer is insufficient.
Please connect AC adapter, 
or stop printing and replace the battery.

Cause : The printer’s battery charge is running low. The printer will not 
work.
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■ Errors where printing is canceled
If any of the following messages appear, printing is canceled. After using the 
recommended solution to clear the error, you need to start the print job over 
again.

Correction : After closing the dialog, turn the printer off and then back on again. 
Paper is automatically ejected from the print receptacle or the paper 
handling slot. Remove the paper and then turn the printer off and 
back on again a second time, and start the print job over.

Correction : Take out the ink cassette from the printer. Remove any slack from the 
ink sheet and then insert the ink cassette back into the printer. If the 
problem still continues, replace the ink cassette with a new one.

Correction : Turn printer off and back on.

Paper jammed in printer.
Clear the jam as follows, then try printing again.
1. Remove the paper that caused the error.
2. Turn printer off and back on.

Cause : Paper is jammed inside the printer while printing, or there is 
paper still inside the printer before printing starts.

Problem with ink cassette.
Correct as follows, then try printing again.
1. Check the state of the ink cassette.
2. Turn printer off and back on.
3. Remove the paper that caused the error.

Cause : There is a problem with the ink cassette.

Communication error. Switch the printer off and on again, and then 
start the print job again.

Cause : There is a problem with communications.
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Correction : Turn printer off and back on, then try printing again.

Correction : Remove paper from the paper cassette, and then make sure to load 
the correct amount of paper in the paper cassette.

In other cases, such as when you specify output for a file or other errors related to 
your system occur, follow the error messages displayed to proceed.

Error in printer.
Turn printer off and back on, then try printing again.

Cause : The printer was not initialized successfully.

Cause : There is too much paper in the paper cassette.
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